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Overview 
 
This booklet provides an introduction to HotHTML 3 Professional. We start with a 
general overview of the major features in HotHTML 3, the system requirements 
and the installation process to correctly installing HotHTML 3. Then we start to 
explore the major features, tools and elements that make up HotHTML 3 and how 
to use them to make your life as a developer easy.  
 
This guide will also teach you the basics of using HotHTML 3, introduce you to the 
user-interface and provide you with step by step tutorials to help you get started 
in using HotHTML 3. 
 
This guide assumes you know at least the basics of HTML and how the internet 
works and that you have FixPack Three or above installed on your system. This 
guide has been written during the development of FixPack 3, therefore some 
features or screens may have non-released build numbers. 
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Introduction 
 
HotHTML 3 Professional allows developers from all areas to use a single 
Integrated Development Environment (IDE) to manage their development needs. 
 
Some highlights of HotHTML 3 include 
 

• Ultra fast Syntax Highlighting & powerful editing features 
HotHTML 3’s new editor contains a powerful syntax engine and editing 
features with book marking, recordable macros and navigation history just 
a few of the many features when working with HotHTML 3. 
 

• SmartPreview – Remote/Server-side Previewing 
Internal previewing of not only static HTML documents but also server-side 
files such as ASP.NET/PHP or ASP documents via a supported web server. 
 
SmartPreview can also preview CSS documents showing you how your 
document will look like without additional coding! 
 

• ProjectExplorer – Manage projects easily 
Internal project management tool to open all your projects – even Visual 
Studio .NET Solutions – in the same IDE. Work on C# or VB.NET 
Windows/Web Form projects easily. 
 

• HotExplorer – Windows® Explorer® like File manger 
Just like Windows® Explorer®, browse and administer your file system 
with the ability to open files over a network share, map drives etc just like 
in Windows® Explorer®. 
 

• DocumentData – Skeletal view of Document 
Get a skeletal view of your SGML (Eg. HTML/XHTML), VB, CSS documents 
with the DocumentData engine. The treeview structure allows you to 
easily walk through your document visually. 
 

• BuildManager – Compile inside the IDE! 
Using BuildManager you can compile .NET, Java, Perl etc documents right 
inside the IDE! 
 

• WebManager – Integrated FTP Editor! 
Manage your remote website via FTP using WebManager with standard FTP 
features as well as real time editing of documents on remote servers. 
 

• CodeCleaner – Keep your code Clean with Tidy! 
Make sure your documents are W3C compliant by validating and checking 
your document against W3C guidelines or indent your document for easier 
reading at a click of a button. 
 

• ActiveTasks – Never forget tasks again! 
Internal task manager allowing you to schedule tasks so you don’t forget 
to do something while working! 

 
Plus many more features tuned for developers from all backgrounds. 
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System Requirements & Things to Consider 
 
In order to use HotHTML 3 Professional you need to be running a Microsoft 
Windows Operating System. Windows 95 is not a supported platform for HotHTML 
3 Professional. 
 
Hardware 
 
The minimum hardware configuration required to run HotHTML 3 Professional 
are: 

- Intel Pentium 166Mhz 
- 32MB RAM 
- Video Adapter capable of at least 640x480x16Bit Colour 
- 20MB Hard Disk Space 

 
For a more favourable performance we recommend the configuration shown 
below: 
 

- Intel Pentium 3 800Mhz + 
- 128MB RAM + 
- Video Adapter/Accelerator capable of 1024x768x32 
- 40MB Hard Disk space 

 
RAM is cheaper these days, so adding a little more RAM to your system can 
greatly improve the overall performance as Windows will find less excuses to use 
a page file. 
 
Software 
 
The minimum software requirements to run HotHTML 3 Professional are: 
 

- Microsoft Windows 98 or NT 4 with Service Pack 6a 
- Microsoft Internet Explorer 4.0 

 
Performance 
For optimal performance, HotHTML 3 should be run on a recent Windows NT 
based Operating System such as Windows 2000, XP or .NET Server 2003. 
 
SmartPreview 
For SmartPreview to work, you will need a web server such as Internet 
Information Services (IIS) or Apache installed on the local or network system 
(you should be able to map the path to a drive accessible on the machine 
HotHTML 3 is installed). To learn how to configure SmartPreview see [ 
Configuring HotHTML 3 > SmartPreview Options > Overview ] in the 
WebHelp Documentation system. 
 
BuildManager 
In order to compile (or build) solutions for external platforms such as Java or 
.NET, the relevant SDKs must be installed so you can configure BuildManager to 
compile the solutions you create. To learn how BuildManager works and how to 
configure a new language see [ Learn HotHTML 3 > Tools > BuildManager > 
Overview ] in the WebHelp Documentation system. 
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Installing & Maintaining HotHTML 3 Professional 
 
We have made installing and maintaining HotHTML 3 easy by using Microsoft 
Windows Installer technology to efficiently manage the process for you. Here is a 
rough guide on installing HotHTML 3. 
 

1. Download the latest distribution 
It’s essential that you have the latest copy of HotHTML 3 before you install 
it. Go to the HotHTML 3 website and see if you have the latest release. 
 

2. Double Click to Extract 
Our installations are compressed and are self-extracting archives, so 
double click on the executable to automatically extract it and launch the 
installation Wizard. After the installation completes, the setup file 
(HotHTML3Eval.msi) is stored in <Program Files>\WebSoftware\Setup 
Files\ folder. You may remove this file manually, however we recommend 
you leaving it so you don’t hunt it down when MSI needs it for 
maintenance. 
 

3. Accept Defaults, Unless… 
We have made it easier to install by ensuring that the default installation 
will suite most users, so unless you know exactly what you are doing or 
you’ve been advised by our support team to do otherwise, choose the 
default options for all the installation dialogs(after the End User License 
Agreement). 

 
The Setup Types 
 
There are three types of setups when installing HotHTML 3: 
 

• Minimal 
This is if you only want to install the CORE editor and the minimal number 
of files to get HotHTML 3 to work. Generally not recommended unless you 
are running low on hard drive space. The minimal setup size is around 
12MB. 
 

• Complete [ DEFAULT ] 
The default option is the complete installation type. This installs ALL CORE 
requirements and all additional items that make up the HotHTML 3 editor. 
This is generally what all users should use, takes up around 20-30MB. 
 

• Custom 
The custom installation type is for advanced users who want to disable 
certain features of the HotHTML 3 editor, or add-ons (such as external 
tools or documentation etc). The size varies on the components selected. 

 
Installation Maintenance 
 
Installing maintenance releases – such as FixPacks – are crucial to ensure 
HotHTML 3 is kept at an optimal state. If a new FixPack arrives (Eg. You have 
FixPack 3 installed, however FixPack 4 arrives) you may simply download the new 
installer and the installer will automatically migrate your installation to the new 
FixPack. However you will loose your existing configuration(s) or settings on the 
machine which will be reset including GUI layouts. 
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Starting HotHTML 3 Professional 
 
After installing HotHTML 3 Professional – and remembering to reboot your system 
if the installer prompts you to  – you can start using HotHTML 3 by either double 
clicking on the desktop icon created or going to “Start > Programs > 
WebSoftware > HotHTML 3 Professional > HotHTML 3” item in the start menu. 

 
When you first launch HotHTML 3, LicenseManager will 
thank-you for installing HotHTML 3 and activate a 30 day 
evaluation copy as shown in the image on the left. 

 
Click OK and you will be shown the “Register & Activate 
Dialog” or otherwise known as the “Evaluation Dialog” as 
shown on the right. It will display the number of days you 
have left to evaluate the software and offer you the 
opportunity to activate your copy to avoid showing the 
evaluation dialog. 
 
For this section, we will continue using the evaluation version, as there is virtually 
no difference from the amount of features or things we can do on either the 
evaluation or the registered version. Click “Continue” to start the initiating 
process for the editor. Alternatively you may register your copy by following 
instructions in WebHelp under [ Licensing > Overview ] topic. 
 
After loading up the splash screen and a few whirls of the hard drive head you will 
see the HotHTML 3 IDE as shown below. There will also be two additional 
windows open; the “Welcome Dialog” and the “Tip of the Iceberg” Dialog. 

 
The Welcome Dialog gives you access to the 
most common tasks you can do with HotHTML 3, 
including creating new documents, opening 
existing documents and viewing pending tasks 
that may need to be completed as well as a 
recently opened document list. 
 
Hovering over each task will give you a small 
description of what the task is in the ‘ActiveHelp’ 
window. 

 
The “Tip of the Iceberg” dialog is a revamp of what most software products have 
– Tip of the Day, we just didn’t like calling it such a boring name so we stuck with 
the Iceberg. 
 
Now we have started HotHTML 3, before we delve into using HotHTML 3 we 
should first discuss what we are seeing on the screen. 
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Dissecting the HotHTML 3 GUI Styles 
 
Let’s talk a little about the IDE itself and how we have created the GUIs so you 
can best use them while you work. 
 
The HotHTML 3 IDE 
 
The first thing you will notice when you start using HotHTML 3 is that there are 
two dockable windows (the NavBar and OutputBar) in the main IDE. 

 
The NavBar is shown on the image on the 
right highlighted in RED (the left part of the 
image). Whilst the OutputBar is shown as 
PINK (the bottom part of the image). 
 
Together these two dockable windows 
contain many of HotHTML 3’s features which 
are easily accessible by activating one of the 
tabs. 
 

 
The Dialog GUIs 
 
As you start using HotHTML 3 you will notice there are no standard windows title-
bars on most windows (except in the Options Dialog). 

 
Let’s take a look at the “Tip of the Iceberg” dialog 
first.  
 
The title bar is the blue area that appears that the 
extreme top of the dialog as shown below: 

 
 

 
The first element (from the left) in the Title-bar is the Dialog Icon; this icon – 
apart from being a visual part of the dialog – has one important and cool feature. 
It allows you to synchronise the Dialog so only the title-bar portion is seen, this 
way we conserve the amount of space the dialog is taking. Go a head, click on 
the animated light bulb icon and watch the dialog slowly collapse and expand 
again when you click it again. After you’ve settled down playing with your new 
addiction lets move on to talk about the other cool thing about HotHTML 3 
dialogs. 
 
That is the auto-positioning of all the dialogs that have the title-bar, the second 
icon on the right (the two windows icon) allows you to dock or position your 
dialog to the bottom right hand corner of the screen, go on and click it - you 
know you to want to see it happen. The left click will place it in the corner, and 
right clicking will show you a list of other positions to automatically put the dialog 
to. 
 
To reposition the form manually simply click on any of the blue areas(or the 
Dialog icon) and hold down on your mouse and drag it to where ever you like. Of 
course the final button on the very right is to close the Dialog itself, nothing too 
cool. 
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The NavBar: A Closer Look 
 
As mentioned previously, by default the NavBar is docked on the left side of the 
HotHTML 3 IDE. The Navbar can only be docked to the left or ride sides of the 
IDE. 

 
NavBar contains six main features (reflected 
by the number of tabs) as shown on the 
image on the left. 

From left to right the tabs: 
 

1. HotExplorer 
HotExplorer is a mini-Windows Explorer like tool allowing you to manage 
your files on your system. It works much the way Windows Explorer does, 
only additionally you can open files within the HotHTML 3 IDE simply by 
double clicking on them or dragging and dropping selected files, create 
new folders, move things around, cut/copy/paste etc. Just like a session of 
Windows Explorer right inside the HotHTML 3 IDE.  
 

2. ProjectExplorer 
ProjectExplorer allows you to manage supported project formats within the 
HotHTML 3 IDE. Unlike in HotHTML 2001 and below, the ProjectExplorer 
tool is now a true integrated feature in the IDE. At FixPack Three, 
HotHTML 3 supports the opening of HotHTML 2001, VS.NET C#/VB.NET, 
VB5/6 Projects/Groups, Visual C++ Workspaces and of course the native 
HotHTML 3 Project format.  
 

3. ActiveLib 
ActiveLib is a generalised tool which can be a great reference or learning 
tool when you’re working with a new language you may not be so familiar 
with. Geared towards non-SGML languages – eg. Not languages that have 
tag elements and attributes like HTML/XHTML or XML but rather languages 
such as Java, VB or Perl. 
 

4. TagLib 
TagLib is much like ActiveLib only for SGML languages like HTML/XHTML 
etc with inbuilt documentation support. Again a great learning or reference 
tool to aid when you’re working in an unfamiliar language. 
 

5. DocumentData 
DocumentData allows you to visually see the skeleton of your document, 
currently there’s support for three types of languages. First is all SGML 
languages (shows tag elements in a document), Cascading Style Sheets 
and Visual Basic files. 
 

6. QuickInsert 
QuickInsert is a collection of useful code fragments – aimed at web 
developers – that you can simply drag and drop into the relevant areas of 
your document. In also encapsulates ClipManager which monitors your 
clipboard for changes allowing you to go back and paste text from the past 
which otherwise would have been lost. All the items in the QuickInsert 
panels are available in the Insert or Format menus as well. 

 
In our path to learning how to use HotHTML 3 we will be using most of the tabs 
that make up NavBar. For a more in-depth look at each feature take a look at the 
help documentation which can be accessed by clicking on the “Help” icon in each 
tab.  
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The OutputBar: A Closer Look 
 
The OutputBar is the other dockable window in the HotHTML 3 IDE, by default its 
docked at the bottom. 
 

The OutputBar contains four main 
features as shown on the left. 

 
From left to right the tabs: 
 

1. ActiveDoc 
ActiveDoc is a document management feature, keeping track of the 
opened documents (and images) inside the HotHTML 3 IDE so you can 
browse through them easily without going through endless menus. 
ActiveDoc has been beefed up since the HotHTML 2001 version by showing 
more information (in real-time) and visually being able to close and save 
documents without even leaving the current document you are working in.  
 
As we work with documents in our tutorials, notice the way ActiveDoc will 
automatically update the list and manage files open in the IDE for you. 
 

2. ActiveTasks 
ActiveTasks allows you to maintain a list of tasks that need to be carried 
out, sort of like a TODO list right inside HotHTML 3. We all know 
developers of any kind aren’t known for their good memory skills. The 
ActiveTasks tab contains a list of the tasks (called ‘TaskList’) that need to 
be fulfilled. We can activate the task to view its details by double clicking 
on it or right click to edit or remove it. 
 

3. Compiler Output 
The Compiler output tab is a component of the BuildManager feature 
which allows you to setup a compiler to build or compile documents right 
inside the HotHTML 3 IDE. The output from the compiler – and viewer – 
appears in the textbox here.  
 

4. CodeCleaner 
CodeCleaner is a tool to help you validate your HTML/XHTML and XML 
documents via the W3C TidyCOM Object. The output from Tidy is parsed 
to an easy to use list shown in this tab. 
 

5. Debug Window 
The Debug Window is only shown if HotHTML 3 is in DebugMode and is 
useful for Plugin Developers and us (WebSoftware) to understand what 
HotHTML 3 was doing when say a crash occurred etc. 

 
When we move into tutorials a little later on we shall use some of the features 
that make up OutputBar to help us be more productive. 
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Creating your first Document 
 
Now that we have familiarised ourselves with the basic GUI that HotHTML is 
comprised of lets go back to where we left off and create our new document. If 
you closed the “Welcome Dialog” it can be accessed again (without restarting) by 
going to File > New > Show Welcome Dialog. A screenshot of what the dialog 
looks like appears below, although yours may not have as many “Recently 
Opened Files” as I have. 
 

 
 
From the list of Tasks select the first ‘Create New 
Document’. This will bring up the “New Document” 
Dialog as shown on the right. 
 
We will first create a simple HTML document to start 
off with. So select “HTML” for the language and 
leave “Load Default Template for Language” option 
selected along with “Ignore Template not Found Errors” checked. This will mean 
that when the new document is created, it will load the default template for that 
language and if the default template does not exist it will not show you any 
warnings. 
 
The default document should look something similar to this, although the 
comments were removed to conserve space. 
 
<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN"> 
<html> 
<head> 
  <title></title> 
  <meta name="Generator" content="WebSoftware HotHTML 3 Professional"> 
  <meta name="HotHTML3.Version" content="v1.0.1900"> 
  <meta name="Copyright" content="Copyright (c) 2005 Thushan Fernando"> 
  <meta name="Rating" content="General"> 
  <meta name="Revisit-after" content="15 days"> 
  <meta name="Robots" content="ALL"> 
  <meta name="Description" content=""> 
  <meta name="Keywords" content=""> 
</head> 
<body> 
</body> 
</html> 
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The default template gives us the basic outline of a document so we can get 
straight into writing code. 
 
Notice that HotHTML 3 has now placed the cursor in between the title tags waiting 
for us to start working straight away? So lets start by changing the title to “My 
First HotHTML 3 Webpage”, which is somewhat more original than the usual 
“Hello World” we know all too well. Also the template should have your name 
instead of “Thushan Fernando” as the examples show for the “Copyright” Meta 
tag element. 
 
Next let’s go in between the BODY tags and enter some text. Just like in 
WYSIWYG editors, HotHTML 3 supports formatting keyboard shortcuts to save 
developers the time to write the code required. The full list of shortcuts can be 
found in the WebHelp Documentation [ Learn HotHTML 3 > Features > 
CodeEditor > Reference > Shortcuts ]. 
 
Lets start by creating a new paragraph in the body by entering CTRL+ENTER 
note that HotHTML 3 has inserted a paragraph tag and placed the caret within the 
tags. Start typing in “This is ” and after the space press CTRL+I which will enter 
the italics tag and once the caret is within the <I> tag press CTRL+B which will 
enter a bold tag within the italics, here we enter the word “cool”.  
 
Your code should be something similar to the code below (the additions we made 
are in RED): 
 
 
<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN"> 
<html> 
<head> 
  <title>My First HotHTML 3 Webpage </title> 
  <meta name="Generator" content="WebSoftware HotHTML 3 Professional"> 
  <meta name="HotHTML3.Version" content="v1.0.1900"> 
  <meta name="Copyright" content="Copyright (c) 2005 Thushan Fernando"> 
  <meta name="Rating" content="General"> 
  <meta name="Revisit-after" content="15 days"> 
  <meta name="Robots" content="ALL"> 
  <meta name="Description" content=""> 
  <meta name="Keywords" content=""> 
</head> 
<body> 
<p>This is <i><b>cool</b></i></p> 
</body> 
</html> 
 

 
Now let’s preview the document so far, to do this simply click on 
the ‘Preview’ tab next to the ‘Editor’ tab in the DocumentWindow. 

 
Alternatively, you may preview the above document inside 
an external browser – such as Firefox – by selecting the 
internet explorer icon in the Standard toolbar and selecting 
“Mozilla Firefox …” from the drop down list as shown on the 
right. Note that the version number will auto update as new 
versions are installed. 
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Using Advanced Tools 
 
Now that we’ve created our first page and previewed it inside our browser lets 
take a look at some of the other features HotHTML 3 has that can aide us in our 
work. 
 
CodeCleaner 
 
CodeCleaner is a tool – powered by Tidy – that ensures that 
any web pages we create are conforming to the W3C 
guidelines and allows us to pinpoint errors and possible 
solutions for these errors.  
 
In FixPack 3, we’ve taken the idea of CodeCleaner to a new 
level by allowing you to simply click on a pre-configured script 
for Tidy from the “CodeCleaner” menu as shown right and 
CodeCleaner will automatically run the selected command for 
us. 
 
The code we created can easily be indented for easier reading – although in this 
case its already an easy to read document – by going to the CodeCleaner > 
Indent HTML item. The document will instantly be reformatted (without the 
need to save the file) and return a slightly more indented version as shown 
below. 
 
 
<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN"> 
 
<html> 
<head> 
  <title>My First HotHTML 3 Webpage</title> 
  <meta name="Generator" content="WebSoftware HotHTML 3 Professional"> 
  <meta name="HotHTML3.Version" content="v1.0.1900"> 
  <meta name="Copyright" content="Copyright (c) 2005 Thushan Fernando"> 
  <meta name="Rating" content="General"> 
  <meta name="Revisit-after" content="15 days"> 
  <meta name="Robots" content="ALL"> 
  <meta name="Description" content=""> 
  <meta name="Keywords" content=""> 
</head> 
 
<body> 
  <p>This is <i><b>cool</b></i></p> 
</body> 
</html> 
 

 
The real handiness of this functionality comes when you are looking through large 
messy files, with CodeCleaner all the hard work is done for you automatically! 
 
You can also use the other functions to easily convert your document to XHTML or 
XML or even upgrade any font tags over to CSS at the touch of a button! 
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QuickInsert 
 
The QuickInsert tool is situated in the last tab on the NavBar 
dockable from the right and houses a collection of commonly 
used snippets of code that web developers may need. These 
can also be retrieved from using the Insert or Format menu 
items. 
 
Using QuickInsert 
To use QuickInsert items, simply click and drag the tag you 
want to insert to the position you want to place the code 
fragment in your document and it will be inserted for you. 
Alternatively you can select a block of text, and double click on 
an item (for instance highlight some text and double click the “Hyperlink” item in 
the “Common Elements” header to insert a hyperlink around the selected text). 
You may also reposition the code fragments to your liking by clicking and moving 
the items with your mouse. 
 
MySnippets 
The MySnippets header contains your personal collection of snippets that you can 
create simply by selecting a block of text, dragging and dropping that block into 
the QuickInsert listbar or alternatively right clicking on the selection and selecting 
Add To MySnippets which is the last option in the context menu.  
 
ClipManager 
QuickInsert contains another neat tool which keeps track of your clipboard. 
ClipManager can store a historical view of items in your clipboard – which are of 
text format – and allow you to insert these items into your document as if they 
were code snippets. You can configure how many snippets you want to store in 
the Option dialog.  
 
ActiveDoc 
 
ActiveDoc maintains a list of documents open inside the HotHTML 3 IDE, simply 
click on the item you want to view and ActiveDoc will automatically bring that 
document into the front for you. You may also right click on any item and 
save/close a document without having to loose focus on the current document 
your working on.
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DocumentData 
 
The DocumentData tool can be invaluable when working on 
large documents to be able to visually walk through a 
documents skeleton to find fragments of code we need. To 
illustrate this, click on the second last tab (from the right) in 
the NavBar to activate the DocumentData window. 
 
By default it will give you a treeview breakdown of the current 
document your working on – in our case it’s the document 
from the “Creating your first Document” section. Simply click 
on any of the tag names to be transported to that location in 
the document. 
 
DocumentData will also give a skeletal view of CSS 
documents, visual basic documents and documents your previewing in the 
“Preview” tab in the editor (to do this force refresh whilst the “Preview” tab is 
selected).

Copyright © 2003 - 2005 Thushan Fernando.  Page 15 of 18 

 



Getting Started with HotHTML 3.0 Professional | 16  
 

 
Advanced Text Editing Features 
 
Now that we have created our first basic document lets learn some advanced text 
editing features in HotHTML 3. 
 
Manipulating Text 
Text blocks can be manipulated directly within the editor, avoiding copying and 
pasting sections to move fragments of text from one area to another.  
 
Some useful methods of manipulating text inside HotHTML 3 include 
 

• Moving blocks of text 
Select the block of text you wish to copy. Then click-and-hold on the black 
selected area and drag it to the desired location and release the mouse 
button. 
 

• Copying selection to another section in the same document 
Select the block of text you wish to copy. Then click-and-hold on the black 
selected area whilst pressing the CTRL key and move the text to the 
desired location. Note that the cursor changes to the copy text cursor. 
 

• Selecting Areas of text 
Sometimes its useful to select only a portion of text instead of an entire 
line blocks. To do this hold down CTRL and select the area of text you 
wish, this will not select entire lines but the boundary you make with your 
mouse. Then normal editing functions – such as Copy/Cut – will only 
utilise the selection selected. Pasting will also insert only the selection you 
copied via this method. 
 

• Typing on multiple lines at once 
Another useful feature we’ve incorporated is 
the ability to type once but make the text span 
multiple lines. To do this hold down CTRL and 
select two or more lines, ensure that there’s no 
selection of text but rather a single line 
appearing in the editor and start typing. You’ll 
be typing the same text on multiple lines at once as shown above.  
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Code Editing Tools 
There are several tools to assist you whilst working with code in HotHTML 3, 
these are located right next to the NavBar as a toolbar. The functionality of some 
of these include: 
 
• Indenting/Unindenting Lines 

Select some lines and let HotHTML 3 indent and unindent them by 
using the first two items in the toolbar. 
 

• Comment/Uncomment Lines 
Select some lines and automatically comment or uncomment the 
selection using the next two items in the toolbar. 
 

• Bookmark Lines 
We all travel back and forth between multiple areas within the same 
document but occasionally we may forget where to go back to. To 
assist us we can create a bookmark for each line we want to keep a 
record of by selecting the bookmark icon (represented by the flag 
icon in the toolbar or in the Bookmarks > Toggle Bookmark menu 
item). Then we can navigate forward or backwards with regards to 
bookmarks using the next two items with the directional arrows. 
 

• Line Navigation History  
If you don’t remember to bookmark a line clicking on the arrow with 
leading dots will return you to the last line you visited and similarly 
allow you to travel forward if the history was not overwritten. 
 

• Record Macro’s 
Macros can greatly simplify repetitive tasks by recording the keystrokes the 
first time and replaying them when needed. To achieve this go to the 
Macros > New Macro menu item and start modifying text as you prefer. 
Notice that there is a popup dialog with a single button with a Stop icon, 
click on this when you want to stop recording your actions. After doing so 
you will be prompted to save this macro for future use. To use it, simply go 
to the Macro > Play Macro X menu item (Where X is the slot you decided 
to save the macro to) and watch HotHTML 3 magically replay the recorded 
macro. 
 

• Find/Replace Dialog 
The find and replace dialog can be activated by hitting CTRL+F or CTRL+H 
on your keyboard. You may find and replace text within the current 
document, just project files or across all open documents inside HotHTML 3. 
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Copyright & Legal Information 
 
Getting Started with HotHTML 3.0 Professional Guide is Copyright © 2003-2005 
Thushan Fernando. 
 
HotHTML 3 Professional is Copyright © 2001-2005 WebSoftware Systems. 
 
HotHTML, HotStyles, WebHelp, WebHelp Tools and SDKs, DialogSDK, 
DialogManager, WebManager, DocumentData, SmartPreview, QuickPreview, 
ProjectExplorer, ActiveDoc, HotExplorer, BuildManager, TagLib, ActiveLib, 
ActiveTask, ActiveTasks, TaskManager are registered trademarks or trademarks 
of WebSoftware Systems. 
 
Portions of HotHTML 3 contains software based on the work by Barry 
Allyn(CodeMax) and Nathan Lewis(CodeSense), the non-derived code are 
copyrighted to their respective owners. Modifications made to the works by the 
two individuals are distributed with permission. 
 
Portions of HotHTML 3 contain components licensed from DataDynamics, 
Innovasys and SkySoftware. 
 
The names of actual companies and products mentioned herein may be the 
trademarks of their respective owners. 
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